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Screen Capture for HP Analyzers—At a Glance

Screen Capture for HP Analyzers is a powerful tool for further processing of 
measurement results and enhancing your measurement reports and rec
Using Screen Capture for HP Analyzers, you can quickly capture the 
following information from your network analyzer or spectrum analyzer:

• Screen shots

• Trace-data values for import into spreadsheets

What is a 
screen shot?

Screen shots are graphics files of the analyzer’s display. Screen Captur
HP Analyzers saves them directly on the hard drive of your PC. Graphics
formats and trace data column delimiters can also be selected. You can im
captured images into word-processing documents, or add callouts to the
images using a popular graphics editing program. You can choose from
variety of graphics formats that are compatible with almost any PC prog

Figure 1. Example of a screen shot in a memorandum.
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What is a trace-data file?

In addition to screens, Screen Capture for HP Analyzers can save trace data 
into ASCII text files. It’s easy to read these files into a spreadsheet for data 
analysis. Trace-data files contain the actual measurement data for each trace 
point along with the key measurement parameters. 

For speed, use the QuickCapture mode

Screen Capture for HP Analyzers provides a QuickCapture mode. Because this 
mode can be pre-configured according to your capture needs, you can per-
form complicated captures with the click of one button. For example, you can 
capture a screen shot and a trace data file simultaneously.

Utilities provide command-line operation

Screen Capture for HP Analyzers comes with several utilities. These utilities 
allow you to save screen captures and trace-data files without displaying 
Screen Capture for HP Analyzers’s graphical user interface and to change the 
format of the trace data files to fit your specific requirements. Refer to Chap-
ter 3, “Utilities” for detailed information.

Figure 2. Trace-data file in Excel.
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Typographical Conventions
Typographical Conventions

The following conventions are used in this book.

Formatting Information

key type Keys or text located on the keyboard or instrument.

softkey type Key names that are displayed on the instrument’s screen.

display  type Words or characters displayed on the computer’s screen or 
instrument’s display.

user type Words or characters that you type or enter.

emphasis type Words or characters that emphasize some point or that are 
used as place holders for text that you type.
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Warranty Information
Warranty Information

Disclaimer 

Statement

While Hewlett-Packard has provided this software for free use and has tested 
it in various applications, Hewlett-Packard does not and cannot warrant the 
software, information, or documentation (including any fixes and updates) or 
the performance or results obtained by using this software, information, or 
documentation. Hewlett-Packard does not and cannot provide any support for 
installing or using the software. This software, information, and documenta-
tion is provided “as is” and Hewlett-Packard will not respond to incompatibili-
ties or fix requests. Hewlett-Packard company makes no warranties of any 
kind, either express or implied, including but not limited to, noninfringement 
of third party rights, merchantability, or fitness for a particular purpose with 
respect to the product and the accompanying written materials. To the extent 
you use or implement this software, information, or documentation in your 
own setting, you do so at your own risk. In no event will Hewlett-Packard be 
liable to you for any damages arising from your use or, your inability to use 
this software, information, or documentation, including any lost savings, or 
other incidental or consequential damages, even if Hewlett-Packard has been 
advised of the possibility of such damages, or for any claim by another party.

HP Software 

License Terms

The following terms govern your use of the Software, unless you have a sepa-
rate written agreement with HP. Using the Software indicates your acceptance 
of the following terms.

Licensed Grant 

HP grants you a license to use the Software. “You” means the company, entity, 
or individual. “Use” means storing, loading, installing, executing, or displaying 
the Software. You may not modify the Software or disable any licensing or 
control features of the Software except as an intended part of the Software’s 
programming features.

Ownership 

The Software is owned and copyrighted by HP or its third party suppliers. 
Your license confers no title or ownership in the Software and should not be 
construed as any sale of the right in the Software. HP’s third party suppliers 
may protect their rights in the event of any violation of these terms.
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Warranty Information
Copies and Adaptations 

You may make copies (but no adaptations) of the Software. You must repro-
duce all copyright notices in the original Software on all authorized copies. Be 
sure to include all the original files and documentation with the copies.

No Disassembly or Decryption 

You may not disassemble, decompile, or decrypt the Software unless HP’s 
prior written consent is obtained. In some jurisdictions, HP’s consent may not 
be required for disassembly or decompilation. Upon request, you will provide 
HP with reasonably detailed information referring any disassembly or decom-
pilation.

Termination 

HP may terminate your license upon notice of failure to comply with any of 
these Terms. Upon termination, you must immediately destroy the Software 
together with all copies, adaptations, and merged portions in any form.

U.S. Government Restricted Rights 

The Software and documentation have been developed entirely at private 
expense and are provided as “Commercial Computer Software” or “restricted 
computer software”. Use, duplication or disclosure by the U.S. Government 
subcontractor is subject to the restrictions set forth in subparagraph (c) (1) 
and (2) of the Commercial Computer Software-Restricted Rights clauses at 
FAR 52.227-19, as applicable. The contractor is Hewlett-Packard Company, 
3000 Hanover Street, Palo Alto, California 93404. 
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Installing Screen Capture for HP Analyzers
Getting Started
Getting Started

Screen Capture for HP Analyzers is an MS-DOS® program. The program will 

run under Windows® 3.1, DOS, and Windows 95™. The program is not com-
patible with Windows NT. In order to run Screen Capture for HP Analyzers, 
your computer should meet the following minimum requirements:

• IBM 386 PC or better, or 100% compatible PC

• VGA video card or compatible

• MS-DOS 5.0 or greater, Windows 3.1, or Windows 95

• 2 MB of RAM

• 3 MB of hard disk space

• Mouse, optional but highly recommended. The mouse is available only when 
running Screen Capture for HP Analyzers under Windows 3.1 or 
Windows 95. Assumes the mouse driver has been installed.

In addition to loading the software, if your analyzer doesn’t have an RS-232 
port, you’ll need to install an HP-IB or GPIB card in your computer. The fol-
lowing cards are compatible with Screen Capture for HP Analyzers:

• HP 82335B or 82335I HP-IB interface cards (DOS based)

• National Instruments™ AT-GPIB/TNT IEEE-488 interface card (DOS 
based), model number 776786-01 (National DOS based driver version 2.7 
or higher only)

• National Instruments PCMCIA-GPIB IEEE-488 interface adapter, model 
number 776857-01 (National DOS based driver version 2.7 or higher only) 
(includes PCMCIA to GP-IB cable)

• Ines PCMCIA to GP-IB IEEE-488 interface adapter (Ines driver version 3.1 
or higher) (includes PCMCIA to GP-IB cable)

• RS-232 serial interface (HP 859x series spectrum analyzers only)
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A computer to HP analyzer interface cable is also required. Choose one of the 
following:

• HP 10833A HP-IB cable, 1 meter

• HP 24542U RS-232 cable, 3 meter (9 pin F to 9 pin F) (for HP 859x series 
analyzers with option 043 only)

• HP 24542G RS-232 cable, 3 meter (25 pin M to 9 pin F) (for HP 859x series 
analyzers with option 043 only)

• HP 13242G RS-232 cable, 5 meter (25 pin M to 25 pin M) (for HP 859x se-
ries analyzers with option 023 only)

C A U T I O N When capturing trace data files, greater than 1000 points long, from an optical 
spectrum analyzer connected to the computer via a National Instruments AT-
GPIB/TNT card, you should exit Windows and run Screen Capture for HP 
Analyzers from the DOS prompt. Failure to do so can cause corruption of the 
trace data file.

When using the National Instruments card, the card’s software drivers should 
be version 2.7 or greater. If you have problems running, upgrade the software 
to version 2.7 or above.

Because graphics file conversion and downloading are very disk intensive 
activities, always install Screen Capture for HP Analyzers on the local drive. 
While there are no limitations to installing the software on a network drive, the 
limited bandwidth of a network drive may significantly reduce the speed of the 
program.
1-4
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Step 1. Install the hardware

1. Install a supported HP-IB or GPIB card in the computer.

Be sure to follow all the instructions in the installation manual that came 
with the card.

When running Screen Capture for HP Analyzers under MS-DOS, Windows 
3.1, or Windows 95 with a National Instruments card, the Screen Capture 
for HP Analyzers software requires the National Instruments AT-GPIB for 
DOS drivers. You do not, however, have to install the Windows 3.1 or Win-
dows 95 drivers.

The Ines card requires the DOS drivers even when the program is running 
under Windows. Edit the autoexec.bat file so it contains lines similar to the 
following:

c:\ines 4882\iepcmcia.exe -io 0 -int 0

c:\ines 4882\ieeeinst.exe /b

2. Connect an HP-IB cable between the computer and the rear panel of the 
analyzer.

In some installations, an optical spectrum analyzer module is installed in an 
HP 70001A mainframe and displayed on a separate HP 70004A display. If 
this is the case, be sure to connect HP-IB cables from both of the main-
frames to the computer.

3. If using an optical spectrum analyzer, set the rear panel switches of the 
HP 70004A as shown in the following table:

Table 1-1. HP 70004A Switch Settings

Switch Setting

HP-IB ON

SYSTEM CONTROLLER 0
1-5



Installing Screen Capture for HP Analyzers
Step 1. Install the hardware
4. Turn on the analyzer.

5. Turn on the computer so the DOS prompt is displayed.

If you use an HP-IB card....

When using Screen Capture for HP Analyzers with an HP 82335 HP-IB card, you do not 
need to install the software that is supplied with the card. Screen Capture for HP Analyz-
ers contains all of the necessary drivers.

If your computer uses an expanded memory manager, be sure to exclude the address 
used by the HP-IB card as described in the manual for the card. Edit the line in the 
CONFIG.SYS file that installs the memory manager. For example, after editing the line 
might look like the following:

DEVICE=C:\DOS\EMM386.EXE X=DC00-DFFF
1-6
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Step 2. Prepare for Windows (optional)

If you installed an HP 82335 card and are going to run Screen Capture for HP 
Analyzers in Windows 3.1 or Windows 95, place a line in the [386Enh] section 
of the SYSTEM.INI file so the address of the card is excluded. Refer to the 
installation manual for the card for a complete explanation. The following line 
is an example for the default select code:

emmexclude=dc00-dfff
1-7
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Step 3. Install the software
Step 3. Install the software

Insert the setup diskette in the computer’s diskette drive.

For MS-DOS installations:

1. Enter a:dossetup <destination directory>

Wait until the program is installed. This example assumes the diskette is 
placed in the computer’s “A” drive.

2. Change to the directory where Screen Capture for HP Analyzers is installed. 

Type capture, and press the Enter key to start.

For Windows 3.1 installations:

1. From the Program Manager File menu, select Run.

2. In the Run dialog box, enter a:\setup. Click OK and then wait until the 
program is installed.

3. Double-click on the Screen Capture for HP Analyzers icon to start the 
program.

Figure 1-1. Screen Capture for HP Analyzers program group and icon.
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For Windows 95 installations:

1. Select Start > Run.

2. Enter a:\setup in the Run dialog box. Click OK and then wait for the 
program to be installed.

3. Click on the Screen Capture for HP Analyzers icon to highlight it. Select 
File > Properties.

4. Select the Program tab by clicking on it. Select the Close on exit option. A 
check mark appears when the option is active. Click OK to close the dialog 
box.

5. Double-click on the Screen Capture for HP Analyzers icon to start the 
program.

6. The Information message shown in Figure 1-2 is displayed. Continue with 
“Step 4. Select the instrument” on page 1-10.

Figure 1-2. The Information message.
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Step 4. Select the instrument
Step 4. Select the instrument

The first time Screen Capture for HP Analyzers is run, the Instrument indica-
tor, located in the lower-right corner of the window, indicates no instrument is 
currently selected.

Figure 1-3. The Instrument Indicator shows no instruments are selected.
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Step 4. Select the instrument
To select the HP instrument series from which you are going to capture data, 
select the desired analyzer on the Communications Setup dialog box.

Figure 1-4. Select the HP instrument and the type of interface.

The next time the Screen Capture for HP Analyzers program is run it defaults 
to the last analyzer selected in the previous session. To select a different ana-
lyzer, click on the Instrument indicator, press F7, or use the Instrument menu.

Parameters Compatible HP analyzers

8560-65 HP 8560E, 8561E, 8562A,B, 8562E RF spectrum analyzers
HP 8563E microwave spectrum analyzer
HP 8564E, 8565E millimeter spectrum analyzer

8591-96 HP 8591C cable TV analyzer
HP 8591E, 8593E, 8594E, 8595E, 8596E spectrum analyzers

8752-53 HP 8752C RF network analyzer
HP 8753D, network analyzers

70950-52 HP 70950A,B, 70951A,B, 70952A,B optical spectrum analyzers
1-11
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Step 5. Configure the interface port
Step 5. Configure the interface port

Use the Communications Setup dialog box to select the HP-IB or GPIB 
address(es) of the instrument with which the Screen Capture for HP Analyz-
ers program will be used. This screen, shown in Figure 1-5, appears the first 
time you run Screen Capture for HP Analyzers. Select the brand of interface 
card to be used. Click Next to proceed.

Figure 1-5. The Communications Setup dialog box.
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The Interface Select Code must be specified for HP 82335 cards. Cards from 
other manufacturers do not use an interface select code. Unless you have 
changed the switch settings on the HP 82335, you will want to use the factory 
default value of 7.

Figure 1-6. Setting the Interface Select Code for the HP-IB card.

The Ines card requires the card address and interrupt level be specified. When 
the computer is turned on, these values are displayed on the screen when the 
autoexec.bat file runs.

Figure 1-7. Setting the card address and interrupt level for the Ines PC card.
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For the HP 70950 series of optical spectrum analyzers:

1. Turn on the optical spectrum analyzer mainframe.

2. On the display module for the optical spectrum analyzer, press the DISPLAY 
key.

3. Press Address Map. This displays the address map showing the MS-IB column 
and row addresses. HP-IB addresses are located along the bottom of the 
map, in row 0. Refer to Table 1-2 for the factory default settings.

4. Rotate the front-panel knob to view the address of the display and the 
address of the optical spectrum analyzer module. The factory default values 
are shown in Table 1-2 below.

If you want to change the addresses used, refer to the optical spectrum an-
alyzer’s Programmer’s Guide.

Table 1-2. Default Factory Settings for Optical Spectrum Analyzers

Settings Default Values

Address of HP 70004A display 4

Address of HP 70950/1/2A,B,C series analyzer module 23

Note

Only optical spectrum analyzers have different bus addresses for the display and for the 
analyzer mainframe. For other analyzers it is important to set both addresses to the 
value obtained in the following procedure.
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For the HP 8560 and HP 8590 series of microwave spectrum 

analyzers:

1. Turn on the spectrum analyzer.

2. Press the CONFIG key.

3. Press the ANALYZER ADDRESS softkey on the front panel of the analyzer. Note 
the HP-IB address displayed at the left side of the screen. The factory 
default is address 18.

For the HP 8750 series of network analyzers:

1. Turn on the network analyzer.

2. Press the LOCAL key.

3. On the front panel of the analyzer, press the SET ADDRESSES softkey.

4. To display the address of your instrument, press ADDRESS:xxxx, where xxxx is 
the model number of your analyzer.

The HP-IB address of the analyzer is displayed on the left side of the screen. 
The factory default is address 16.

For RS-232 communications

You must specify the COM port on the PC to which the 8590 series is con-
nected. There is no analyzer address to specify.

Figure 1-8. Setting the COM port when using the RS-232 interface.
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When either the RS-232 port of the National Instruments PC MCIA/GPIB 
interface is selected a warning message is displayed.

Figure 1-9. The RS-232 and National Instruments PC MCIA/GPIB warning message.

This completes “Step 5. Configure the interface port” . Before moving on to 
“Step 6. Set the defaults” , confirm the addresses listed in the Bus Settings for 
Instruments dialog box match the address setting(s) you just obtained.

Use the mouse, or left and right arrow keys, to change address values in the 
dialog box. Press Tab to move from one field to another. Press Enter when fin-
ished.
1-16
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Step 6. Set the defaults

To enter the default settings, on the File menu, select Capture Defaults. The 
Capture Defaults dialog box is displayed. 

Figure 1-10. The Capture Defaults dialog box.
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Select the desired options:

Options Description

QuickCapture mode Selects the type of data to be included in a 
QuickCapture: screen dump, trace points, or both.

QuickCapture graphic format Selects the graphics format for saving screen shots 
captured in the QuickCapture mode.

Delimiter between columns Selects the ASCII character, either commas or tabs, 
used to separate columns of information in trace-data 
files.

Extension to save trace files 
under

Selects the file extension appended to the file names of 
trace-data files. The default extension is TXT.

Include header descriptions When active, this option adds a description to column 
headers, in addition to the number printed above each 
column. For example, “Resolution Bandwidth” and 
“Number of Points”.

Include tabulated X-axis values When active, this option causes the corresponding 
frequency, wavelength, or time value to be printed next 
to each trace-data point. These values are placed in the 
first column of the file.

Include softkeys in graphics Includes softkeys in the captured image. Softkeys are 
the function labels displayed on each side of the 
display graticule. Not all analyzers recognize this 
option.

Disable graphic preview Normally, each image is displayed as it is saved. You 
can reduce the time required for captures by disabling 
the graphics preview. Not all analyzers allow HP-GL 
files to be previewed.
1-18
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What you’ll find in this chapter

Capturing Images   2-4
To capture a screen shot   2-6
To create a color PCX or BMP file   2-7
To view a captured image file   2-8

Capturing Trace Data   2-9
To capture a trace-data file   2-13
To view a trace-data file   2-13
To import trace data into Microsoft Excel™ 5.0   2-13
To import trace data into Lotus 1-2-3 release 5   2-14
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Capturing Images and Traces
Capturing Images and Traces

In this chapter, you’ll learn how to capture screen shots and trace-data files. 
Some practical tips and information on file formats are provided that won’t 
take long to read but will help you to achieve the best results. 

Figure 2-1. Captured screen.
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Capturing Images

Before you start capturing images, determine which graphics format you need. 
Selecting the wrong format can waste valuable time! Screen Capture for HP 
Analyzers allows you to select from one of five graphics file formats:

Are you going to import your files into your word processor or desktop pub-
lishing software? First, capture one screen, and try importing it. Be aware that 
resizing a BMP, PCX, or TIFF image can degrade its viewed or printed image. 
The file itself should not be affected. This depends, of course, on the software 
you are using. If one format doesn’t work well, try another one. 

The images created by Screen Capture for HP Analyzers are black and white, 
except for those saved in the HP-GL format, which is color. If you need a color 
PCX or BMP file, refer to “To create a color PCX or BMP file” on page 2-7. 

To view HP-GL files within Screen Capture for HP Analyzers, always add the 
HGL extension to the file name. If your application expects a different file 
extension, for example HPG, Screen Capture for HP Analyzers can still capture 
and save the screen, but will not be able to display it again.

Format Description

BMP™ Bitmap format used by MS Windows. Uses filename extension BMP.

GIF This bitmap format tends to have smaller file sizes than the other formats. 
This format is a product of CompuServe Incorporated. Uses filename 
extension GIF.

HP-GL This is a vector format originally designed for plotters. Uses filename 
extension HGL.

PCX Bitmap format owned by ZSoft Corporation. This format is widely used 
and supported. Uses filename extension PCX.

TIFF Bitmap format owned by the Aldus Corporation.The TIFF files created by 
Screen Capture for HP Analyzers conform to version 5.0, class B with 
packbits compression. Uses filename extension TIF.
2-4
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HP-GL file colors may look strange

Sometimes, word processor or graphics programs display captured HP-GL 
screens using the wrong colors. This occurs because the HP-GL graphics for-
mat does not contain any color information. Because HP-GL was originally 
designed for drawing on plotters using default pen definitions, this format sim-
ply indicates which pen to use. Your word processor decides which color to 
assign to different pen numbers. 

Another source of potential color problems is the ability to change the colors 
on some analyzer screens. For example, if you define trace A to be hot pink on 
the HP 70004A display, the file will not have a hot pink trace when imported 
and displayed in your word processor. Screen Capture for HP Analyzers views 
HP-GL images using a set of default colors, therefore the modified color will 
not be displayed in Screen Capture for HP Analyzers.

Translating files to another format

If you need a format not provided by Screen Capture for HP Analyzers, you 
can purchase one of the many graphics file translation programs available on 
the market today. To ensure your graphics file retains its quality, translate bit-
map formats to bitmap formats and vector formats to vector formats. Avoid 
translating vector to bitmap or vice versa. The graphics file formats created by 
Screen Capture for HP Analyzers are bitmap, except for HP-GL, which is a vec-
tor format.

Do not save files directly to a diskette

Sometimes, you may need to place your captured files on a floppy diskette for 
transferring or storing data. Do not save the files directly on the diskette 
because there may not be enough diskette space available for proper program 
operation. Instead, save the files to a directory on the hard drive in your com-
puter. Then, copy your files to the diskette. You’ll find this method is more 
reliable and takes less time.
2-5
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To capture a screen shot

1. From the Capture menu, select Default. The image will be captured and 
saved using the settings selected in “Step 6. Set the defaults” on page 1-17.

If the default settings are not configured, or if you want to save the image 
in a graphics file format other than the one defined in the Default menu, se-
lect one of the five available formats shown in the menu: BMP, GIF, HP-GL, 
PCL, PCX, or TIFF.

Figure 2-2. The Capture menu.

2. Screen Capture for HP Analyzers displays the image after capturing it, 
unless the Disable Graphic Preview option has been selected. Press the Enter 
key to continue.

3. Enter the name of the file.

Use the suggested file extension characters, or enter your own. HP-GL files 
must use the HGL extension in order to be viewed by Screen Capture for HP 
Analyzers. If another extension is used, for example PLT or HPG, you will be 
able to capture the image, but Screen Capture for HP Analyzers cannot dis-
play it.

When you are saving a file, you can change the targeted directory. 
2-6
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To create a color PCX or BMP file

This procedure requires that Screen Capture for HP Analyzers is run-

ning in Windows 3.1 or Windows 95. 

1. Start Paintbrush™1, and minimize it to an icon.

2. Run Screen Capture for HP Analyzers in a full MS-DOS window.

3. Use Screen Capture for HP Analyzers to capture and view an HP-GL file. 
(Make sure the Disable Graphic Preview option is not selected.)

4. While the file is displayed, press Alt-PrntScrn to copy the display to the 
Clipboard. 

5. Press Alt-Tab to switch to the Paintbrush window.

You can use another graphics program to accomplish this task, or, you can 
simply paste the file into your favorite application and skip to Step 7 be low.

6. Maximize the window, and on the Edit menu select Paste to insert the file 
from the clipboard.

7. Save the file in the PCX or BMP format.

8. If you need another color bitmap format, use the imgconv.exe utility 
provided with Screen Capture for HP Analyzers. Refer to Chapter 3, 
“Utilities” for information on using this utility.

1. Paintbrush is a trademark of ZSoft Corporation.
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To view a captured image file

Screen Capture for HP Analyzers was designed to view files created by Screen 
Capture for HP Analyzers.

Screen Capture for HP Analyzers may not be able to view files created by 
other programs.

1. On the File menu, select View. The Open File dialog box opens.

2. Enter the name of the file you wish to view in the Filename field.

3. The selected image will be displayed until you press the Enter key.
2-8
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Capturing Trace Data

Captured trace-data files contain the actual measurement data for each dis-
played trace. For example, if traces A and B are displayed on the display of the 
spectrum analyzer, the corresponding trace-data file contains data for both 
trace A and trace B. Because trace-data files are ASCII files, you can import 
them into spreadsheets and edit them in word processors.

Trace files include a header

At the start of the file, before any trace data, there is a header section. The 
header consists of several lines that describe the file and the settings of the 
spectrum analyzer at the time the data was captured. By setting the defaults 
of the Screen Capture for HP Analyzers software, you can prevent descrip-
tions from being added to the values listed in the header. Table 2-1, Table 2-2, 
and Table 2-3 show different possible file headers.

Trace data is placed in columns

After the header, the remaining lines contain trace data. Each data point is 
placed on a separate line. If the file contains data for more that one trace, for 
example trace A and trace B, the data is placed in separate columns. On each 
line, the columns of data are separated by a delimiting character. Although the 
default delimiter is the tab character, you can change it using the Capture 
Defaults dialog box. Refer to “Step 6. Set the defaults” on page 1-17 for infor-
mation on setting the default options. You can also choose to add x-axis values 
to your trace-data files. 

The frequency, or wavelength, of each trace point, i, is calculated according to 
the following formula:

where N is the total number of points in a given trace. The actual number of 
trace points depend on the analyzer from which the data is taken. 

fi fstart
i 1–

N
----------- fspan×+=
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If the x-axis units are time, the time value of each trace point, i, is calculated 
using the following formula: 

Table 2-1, Table 2-2, and Table 2-3 show example spreadsheet files. The appli-
cation default values are listed in each table title. Notice that the values listed 
in the header on Table 2-1 are clearly labeled. Also notice that three traces are 
included and that a comma character was selected to separate the data 
between columns. 

Number formats are not changed

Screen Capture for HP Analyzers does not alter the format of the data or the 
trace length. For example, if logarithmic data is displayed on the spectrum 
analyzer, the file will contain logarithmic data. Data values are listed without 
units. (If units were included, the spreadsheet program would interpret the 
data as text instead of numbers.) For example, –6.94 dBm is recorded in the 
file as –6.94. Linear data is listed using scientific notation. For example, the 
number 0.00192 is listed as 1.92E–3. All values are listed in SI units (Interna-
tional System of Units), such as meters and seconds, except power.

Customizing the format of the trace data

Each analyzer that Screen Capture for HP Analyzers supports has a corre-
sponding file in the Screen Capture for HP Analyzers directory with the exten-
sion MOD. By modifying these MOD files with a text editor, you can tell Screen 
Capture for HP Analyzers to print trace data to a specific decimal position, to 
only print portions of a trace, and so forth. Refer to Chapter 3, “Utilities” for 
more information.

Simultaneous captures with QuickCapture

If you selected simultaneous image and trace-data file captures, Screen Cap-
ture for HP Analyzers does not prompt you for the name of the trace-data file. 
Instead it will use the base file name entered for the image file and append the 
appropriate file extension. For example, if you captured an image file named 
test.tif, Screen Capture for HP Analyzers would automatically create a trace-
data file named test.txt.If a file with this name already exists, Screen Capture 
for HP Analyzers will prompt you for a new filename before overwriting it.

ti
i 1–

N
----------- tsweep×=
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Figure 2-3. Captured trace-data file from an optical spectrum analyzer.

Table 2-1. Trace-data file with default options:
[X] Include header descriptions
[X] Include tabulated x-axis values

Tue Aug 15 15:55:25 1995
Instrument ID: ,HP70950A
Amplitude units: ,DBM
Start wavelength: ,1.3565E-6
Stop wavelength: ,1.5565E-6
Resolution bandwidth: ,2.00E-9
Reference level: ,-16.75
Sweep time: ,92.160E-3
Sensitivity: ,-57.54
Video bandwidth: ,19.3E+3
Trace A number of points: ,800
Trace B number of points: ,800
Trace C number of points: ,800

Wavelength (nm),Trace A,Trace B,Trace C
1356.50000,-57.80,-64.36,-63.06
1356.75031,-60.76,-63.28,-62.43
1357.00063,-59.36,-65.26,-62.91
1357.25094,-61.46,-63.49,-63.56
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Table 2-2. Trace-data file with default options:
[  ] Include header descriptions
[X] Include tabulated x-axis values

Tue Aug 15 15:59:55 1995
HP70950A
DBM
1.3565E-6
1.5565E-6
2.00E-9
-16.75
92.160E-3
-57.54
19.3E+3
800
800
800

Wavelength (nm),Trace A,Trace B,Trace C
1356.50000,-57.80,-64.36,-63.06
1356.75031,-60.76,-63.28,-62.43
1357.00063,-59.36,-65.26,-62.91
1357.25094,-61.46,-63.49,-63.56

Table 2-3. Trace-data file with default options:
[X] Include header descriptions
[  ] Include tabulated x-axis values

Tue Aug 15 16:01:53 1995
Instrument ID: ,HP70950A
Amplitude units: ,DBM
Start wavelength: ,1.3565E-6
Stop wavelength: ,1.5565E-6
Resolution bandwidth: ,2.00E-9
Reference level: ,-16.75
Sweep time: ,92.160E-3
Sensitivity: ,-57.54
Video bandwidth: ,19.3E+3
Trace A number of points: ,800
Trace B number of points: ,800
Trace C number of points: ,800

Trace A,Trace B,Trace C
-57.80,-64.36,-63.06
-60.76,-63.28,-62.43
-59.36,-65.26,-62.91
-61.46,-63.49,-63.56
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To capture a trace-data file

1. On the Capture menu, select Trace Data (ASCII) or press F6. If the default 
settings are not configured, select Trace Data (Text).

2. Screen Capture for HP Analyzers displays the file after capturing it. You are 
prompted for a filename.

3. Enter the name of the file in the Filename entry field. When saving a file, 
you can change the targeted directory. When you are satisfied with your 
entry, press Enter. 

To view a trace-data file

1. On the File menu, select View. The Open File dialog box opens.

2. Enter the name of the file you wish to view in the Filename field.

3. The selected trace data file will be displayed until you press the Enter key.

To import trace data into Microsoft Excel™ 5.0

1. Capture a trace-data file. Refer to “To capture a trace-data file” above.

2. Start Microsoft Excel.

3. Select File and then Open.

1. On the File menu, select View. The Open File dialog box opens.

2. Select Text Files in the List Files of Type field.

3. The “Text Import Wizard” will step you through importing the file. Trace-
data files are delimited.
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To import trace data into Lotus 1-2-3 release 5

1. Capture a trace-data file. Refer to “To capture a trace-data file”.

2. Start Lotus 1-2-3.

If you are using a Windows version:

3. On the File menu, select View. The Open File dialog box opens.

4. Select Text File in the List Files of Type field.

5. Click on Text Options.

6. Select either Separator TAB or Separator comma depending on the 
delimiter used in your file.

7. Click on OK.
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When you installed Screen Capture for HP Analyzers, several utilities were 
copied into the Screen Capture for HP Analyzers directory. These utilities 
allow you to capture, convert, and view files from the MS-DOS command line. 
Because they don’t display windows or menus, these utilities are ideal for 
applications such as MS-DOS batch files.

Utility Description

tracepts.exe Downloads a trace-data file from the analyzer. The format of the trace-
data file is determined by the .mod script for that instrument model.

gxfile.exe Downloads an HP-PCL or HP-GL file from the analyzer. Always run 
mkhpgl.exe on the captured file.

mkhpgl.exe Prepares downloaded HP-GL files for viewing and saving.

imgview.exe Displays BMP, GIF, PCX, and TIFF files captured by Screen Capture for 
HP Analyzers.

viewhpgl.exe Displays HP-GL files captured by Screen Capture for HP Analyzers.

imgconv.exe Converts raster data from the analyzer to one of the supported graphics 
file formats.
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tracepts.exe

Downloads a trace-data file from the analyzer, using the output-formatting 
and bus commands appropriate for that instrument model. The script lan-
guage of the .mod file that tells tracepts.exe how to interact with each instru-
ment is outlined below, for the benefit of users who wish to change how the 
trace data appears in the output file. (If no output filename is provided, the 
instrument writes the trace data to the console.)

Command

tracepts [/I][/P][/T][/D][/W][/H][/N] [/O <output filename> ]  
<model script filename>

Table 3-1. Command Arguments

Argument Description Default Value

/Ix Interface select code [0-16] 7

/Px Primary address [0-30] 18

/Tx Timeout (seconds). Zero disables timeout. 5.0 

/Wx Minus (–) prevents x-axis values from being added 
to the file. Plus (+) adds x-axis values.

plus (+)

/Hx Minus (–) turns header labels off. Plus (+) turns 
header labels on.

minus (–)

/Dx Delimiter [0-255] comma (ASCII 44)

/N Use National Instruments GPIB card use HP 82335 
HP-IB card

/Eaxb Use Ines card at address b, interrupt a

/x Use RS-232 prot COM x
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Example

tracepts /I7 /P18 /W- /H- /D44 /Oc:\test.txt 859x.mod

Script Language Syntax

The utility program tracepts.exe does not have any knowledge of a particular 
instrument’s bus command set, or other device-dependent information, such 
as how many traces the analyzer stores and how many data points are col-
lected for each trace. This information is contained externally in a text file, so 
that it is easy to alter the program’s behavior when interacting with a particu-
lar analyzer. The bus-oriented script language that the file is written in has 
features, such as conditional (if-else) statements and formatted printing, 
besides commands to coordinate the exchange of data between the PC and 
the analyzer.

The most basic script file would look something like:

buckets 101
send TRACE?; 
transfer 
dump

The first statement assigns the value 101 to the variable buckets. The second 
sends an ASCII command string across the bus to the analyzer. The third 
statement accepts from the analyzer 101 byte pairs representing the ampli-
tude samples, which are printed out in tabular form by the fourth statement. 
The analyzer’s “TRACE?” query was terminated with a semicolon (;), but it 
could just as well have been terminated with a linefeed (\n).
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Variables

The following is a more complex script file, which queries a particular analyzer 
for the number of data samples in the trace, as well as their frequency range, 
and prints only the first ten samples in scientific notation with two significant 
figures beyond the decimal point:

send POINTS?; 
buckets 
send FSTART?; 
lower 
send FSTOP?; 
upper 
send TRACE?; 
format %.2f 
transfer 
format %g 
dump 0 9

In this case, values were assigned to three variables (buckets, lower and 
upper) by the analyzer itself. Each assignment was preceded by a query 
across the bus and, since the variable’s name wasn’t followed by a value, 
tra cepts.exe converted the analyzer’s response into a real number and stored 
it in the variable. A fourth variable, format, was explicitly set twice: first to 
“%.2f” for the amplitude column and then to “%g” for the frequency column.

The format variable must be a valid conversion string for the standard C func-
tion printf(). A percent sign (%) indicates the start of the conversion; it may 
be followed by a field width. The presence of a decimal point followed by 
another number indicates how many digits after the decimal point are desired. 
A final “e” or “f” character forces real numbers to be printed in scientific nota-
tion or fixed-point, respectively. (If the last character is “g”, they are printed 
in either scientific notation or fixed-point, whichever is the more compact.) 
The commands pop , transfer , and dump require this kind of format. A 
transfer  ascii  command, on the other hand, requires a string format, 
which means a percent sign (%), then a field width (optional), then a decimal 
point and the maximum number of characters from the string to print 
(optional), followed by an “s”.

The only variable that tracepts.exe requires in order to perform a trace-data 
transfer is buckets. If no other ones are set, however, the data points for the 
trace will be printed exactly as they are returned from the instrument: as inte-
gers in arbitrary “measurement units” decided by the analyzer. For each two-
byte integer x, tracepts.exe prints amplitude values according to the relation:
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where reflevel, db/div, afactor, fullscale, and aoffset are variables whose 
default values are 0, 1, 1, 1, and 0 respectively. The units to be printed at the 
top of the column of amplitude data can be assigned to the string variable 
aunits.

Similarly, the variable funits can be set to units other than “Hz,” and the fre-
quency value corresponding to the nth trace point is printed according to the 
following relation involving the variables lower, upper, buckets, foffset, and 
ffactor:

In summary, script language variables control the way frequency and ampli-
tude values are transferred, converted into meaningful units or printed to the 
output file. Variables may be set in one of two ways: the variable’s name may 
precede the assigned value (separated from it by at least one space) or the 
name may appear alone on the line, in which case its value is read from the 
analyzer. In the latter case, a send  command querying the analyzer must pre-
cede the assignment.

Commands

The first sample script contained the commands send , transfer , and dump. 
Script commands are executed in order, and directly control either the activ-
ity on the bus or the output file content. The table below summarizes them.

reflevel db div⁄( ) afactor
x

fullscale
----------------------- aoffset+⋅ 

 ⋅+

ffactor lower n
upper lower–

buckets a–
------------------------------------⋅+ 

  foffset+⋅
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Table 3-2. Commands in the TRACEPTS.EXE Script Language

Syntax Example Description

timestamp timestamp writes the current date and time to the 
output file.

print print prints the delimiter character (comma by 
default) to the ouput file. Ignored if the /H- 
option is specified.

print <text string> print Trace 
A\n (i.e., “Trace A” 
plus a linefeed.)

prints <text string> to the output file. (if 
the /H- option is specified, only print 
\n  lines are processed.)

include <filename> include 
generic.inc

processes script commands in <filename>, 
then resumes at the next statement in the 
current file.

send <bus command> send CLEAR; sends <bus command> to the analyzer.

echo echo copies the next line output by the analyzer 
to the output file.

clear clear sends a “device clear” command to the 
interface card.

transfer [<skip1> 
[<skip2>]]

format %10.4g
transfer 10

transfers from the analyzer to the PC a 
series of two-byte integers, the number of 
which is determined by the buckets 
variable. The first <skip1> bytes and the 
last <skip2> bytes are ignored. The format 
variable’s value must be of the form 
“%...e”, “%...f”, or “%...g”.

transfer ascii
[<conv. string>]

format %.10s
transfer

ascii
%*[^,]%*c%s

(ignore the first comma 
on each line from the 
analyzer and the 
characters preceding it, 
but transfer the next ten 
characters on the line.)

transfers from the analyzer to the PC a 
series of line-feed-terminated ASCII lines, 
the number of which is determined by the 
buckets variable. The format variable’s 
value must be of the form “%...s”. If <conv 
string> is present, it must contain at least 
one “%[...]” or “%s” to extract the desired 
characters, and may contain one or more 
“%*” that signify skipped portions of the 
line.
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dump [<start><end>] format %g
dump 0 99

copies to the output file the data that was 
accumulated by any previous 
transfer  commands. All data points 
from 0 to buckets-1 are copied unless 
<start> and <end> are specified. The 
format variable affects how the frequency 
values (i.e., the leftmost column) are 
printed. If the /W- option was specified, 
they are not printed at all.

exit exit causes tracepts.exe to terminate and 
return control to DOS.

rpncalc +|–|*|/|^|x push 9
push 5
rpncalc +
pop
(will print “14” to the 
output file)

performs the indicated operation on the 
two real numbers most recently pushed 
onto the stack (with the push  command 
described below). The result of the 
operation replaces them. “^” means 
exponentiation; “x” means swap the 
numbers, leaving them on the stack.

push [value] push as in the previous example, pushes a real 
number onto the stack. If no value follows 
the command, one is read from the 
analyzer in ASCII format.

pop format %f
pop

prints the topmost value on the stack to 
the output file. The value of the format 
variable must be of the form “%...e”, 
“%...f”, or “%...g”.

Table 3-2. Commands in the TRACEPTS.EXE Script Language (Continued)

Syntax Example Description
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Program flow

There are two additional script language statements that, instead of copying 
the analyzer’s output in some way, take such output into consideration and 
decide which commands in the file get executed next. They are if response 
and if matches. Their syntax is as follows:

if <condition> 
{ 

* statements to process should <condition> be true 
} 
else 
{ 

* statements to process should <condition> be false 
}

The if statement, the opening and closing braces, and the else statement each 
must appear on their own individual lines. An if statement must always be pre-
ceded by a send command that queries the analyzer for an ASCII response, 
since the purpose of the if is to cause tracepts.exe to behave differently 
depending on the status of the analyzer. Whether to use response or matches 
as the first keyword in the condition depends on whether the analyzer’s reply 
to the last query is to be tested against a specific series of characters, or 
against its reply to a second query. An illustrative example is shown below:

send ID?; 
if response HP856 
{ 

send FA?; 
if matches FB?; 
{ 

* FA? and FB? generated the same response 
print Spectrum analyzer is in zero-span mode.\n 

} 
} 
else 
{ 

* ID? didn ′t generate a response like ″HP8563E″, etc. 
print Not a Hewlett-Packard 856x-series analyzer.\n 

}

Note that an asterisk (*) begins a comment line, and that if statements can be 
nested.
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gxfile.exe

Downloads an HP-PCL or HP-GL file from the analyzer. You must append an 
explicit command (from the analyzer’s HP-IB command set) that instructs it 
to begin a print or plot of the data on its screen to the HP-IB bus. If the output 
file is in HP-GL format (in response to a plot command), always run 
mkhpgl.exe in order to make important modifications to the file.

To create BMP, TIFF, PCX, or GIF format files, first capture an HP-PCL file, use 
mkhpgl.exe to modify the file, and then use imgconv.exe to convert the modi-
fied HP-PCL file to the desired format.

Command

gxfile [/I] [/P] [/T] [/N] /S<command> <output filename>

Example

gxfile /I7 /P18 /T0 /SPRINT0;

Table 3-3. Command Arguments

Argument Description Default Value

/Ix Interface select code [0-16]. 7

/Px Primary address [0-30]. 18

/Tx Timeout (seconds). Zero disables timeout. 5.0 

/S<command> Command from analyzer’s HPIB command set that 
begins a print or plot. The command string may not 
contain any spaces.

none (mandatory)

/N Use National Instruments GPIB card. use HP 82335 card
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mkhpgl.exe

This utility prepares downloaded HP-GL files for viewing and saving. To 
ensure successful captures, always use this utility on all HP-GL files. (Of 
course, all this is done automatically when Screen Capture for HP Analyzers is 
used.)

Command

mkhpgl.exe <input filename> <output filename>

Example

mkhpgl.exe temp.hgl fig1.hgl
3-12



Utilities
imgview.exe
imgview.exe

Displays BMP, GIF, PCL, PCX, and TIFF files.

Command

imgvview <input filename>

Example

imgvview fig1.pcx
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viewhpgl.exe

Displays HP-GL files.

Command

viewhpgl <input filename>

Example

viewhpgl pict1.hgl
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imgconv.exe

Converts files to a different graphics file format. If the /F  argument is not 
specified, imgconv  selects the file types based on the filename extensions.

Command

imgconv <input filename> <output filename>  [/F]

Input and output files must be one of the formats listing in the following table.

Example

imgconv test.pcl test.tif

or

imgconv test.pcx abcd.efg /ftif

Table 3-4. Command Arguments

Argument Description

/FBMP Creates a BMP file.

/FPCL Creates a HP-PCL file.

/FTIF Creates a TIFF file.

/FPCX Creates a PCX file.

/FGIF Creates a GIF file.
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Hewlett-Packard Sales and Service Offices

Hewlett-Packard Sales and Service Offices  (1 of 2)

U.S. FIELD OPERATIONS

Headquarters
Hewlett-Packard Company
19320 Pruneridge Avenue
Cupertino, CA 95014 U.S.A.
(800) 752-0900

California, Northern
Hewlett-Packard Company
301 East Evelyn
Mountain View, CA 94041
(415) 694-2000

California, Southern
Hewlett-Packard Company
1421 South Manhatten Ave.
Fullerton, CA 92631
(714) 999-6700

Colorado
Hewlett-Packard Company
24 Inverness Place, East
Englewood, CO 80112
(303) 649-5000

Georgia
Hewlett-Packard Company
2000 South Park Place
Atlanta, GA 30339
(404) 955-1500

Illinois
Hewlett-Packard Company
5201 Tollview Drive
Rolling Meadows, IL 60008
(708) 342-2000

New Jersey
Hewlett-Packard Company
120 West Century Road
Paramus, NJ 07653
(201) 586-5400

Texas
Hewlett-Packard Company
930 East Campbell Road
Richardson, TX 75081
(214) 231-6101

EUROPEAN FIELD OPERATIONS

Headquarters
Hewlett-Packard S.A.
150, Route du Nant-d’Avril
1217 Meyrin 2/Geneva Switzerland
(41 22) 780.8111

France
Hewlett-Packard France
1 Avenue Du Canada
Zone D’Activite De Courtaboeuf
F-91947 Les Ulis Cedex France
(33 1) 69 82 60 60

Germany
Hewlett-Packard GmbH
Hewlett-Packard Strasse
61352 Bad Homburg Germany
(+49 6172) 16-0

Great Britain
Hewlett-Packard Ltd.
Eskdale Road, Winnersh Triangle
Wokingham, Berkshire RG11 5DZ
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Hewlett-Packard Sales and Service Offices
INTERCON FIELD OPERATIONS

Headquarters
Hewlett-Packard Company
3495 Deer Creek Rd.
Palo Alto, California 94304-1316
(415) 857-5027

Australia
Hewlett-Packard Australia Ltd.
31-41 Joseph Street
Blackburn, Victoria 3130
(61 3) 895-2895

Canada
Hewlett-Packard Ltd.
17500 South Service Road
Trans-Canada Highway
Kirkland, Quebec H9J 2X8
Canada
(514) 697-4232

China
China Hewlett-Packard Company
38 Bei San Huan X1 Road
Shuang Yu Shu
Hai Dian District
Beijing, China
(86 1) 256-6888

Japan
Yokogawa-Hewlett-Packard Ltd.
1-27-15 Yabe, Sagamihara
Kanagawa 229, Japan
(81 427) 59-1311

Singapore
Hewlett-Packard Singapore Ltd.
Pte. Ltd.
Alexandra P.O. Box 87
Singapore 9115
(65) 271-9444

Taiwan
Hewlett-Packard Taiwan
8th Floor, H-P Building
337 Fu Hsing North Road
Taipei, Taiwan
(886 2) 712-0404

Hewlett-Packard Sales and Service Offices  (2 of 2)
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HP-IB
address, 1-12
cable, 1-5
cards, 1-3, 1-6

HP-PCL file
displaying, 3-13
downloading, 3-11

I
imgconv.exe, 2-7, 3-15
imgview.exe, 3-13
importing trace data, 2-13
Ines GPIB-PCMCIA card, 1-3, 1-5, 1-13
installing

hardware, 1-5
on a network, 1-4
software, 1-4, 1-8

instrument selection, 1-10
interface port, configuring, 1-12

L
Lotus 1-2-3

importing trace-data, 2-14

M
Microsoft Excel, 2-13
mkhpgl.exe, 3-12
modifying a file, 3-11
module address, 1-14
MS Windows, 1-7
MS-DOS, 2-7

batch files, 3-3
installation, 1-8

N
National Instruments

AT-GPIB/TNT card, 1-3, 1-5
PC MCIA/GPIB, 1-3

network, installing on a, 1-4

P
Paintbrush, for color file, 2-7

PC MCIA cards, 1-3
PCX format files, 2-4

creating, 3-11
displaying, 3-13

Q
QuickCapture, 1-18, 2-10

R
requirements for hardware, 1-3
RS-232 port, 1-3, 1-15
running under Windows, 1-5

S
sales and service offices, 4-3
saving files, 2-5, 3-12
screen shots, iii

capturing, 2-6
script file, 3-5
select code, default, 1-7
selecting the instrument, 1-10
service and sales offices, 4-3
setting defaults, 1-17
software, installing, 1-4, 1-8
spreadsheet

data, 2-9
data separator, 2-10
files, iv

switch settings, HP 70004A, 1-5
system controller switch setting, 1-5
system.ini file, 1-7

T
Text Import Wizard, 2-13
TIFF format files, 2-4

creating, 3-11
displaying, 3-13

time value calculation, of trace point, 2-10
trace point calculation, 2-9
trace-data file, iv

capture via utility program, 3-4
capturing, 2-9, 2-13
downloading, 3-4
examples of, 2-11
filenames, 2-10
header, 2-9
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importing to Excel, 2-13
importing to Lotus 1-2-3, 2-14
number format, 2-10
viewing, 2-13
wavelength equations, 2-9

tracepts.exe, 3-4

U
utilities, 3-3

gxfile.exe, 3-11
imgconv.exe, 3-15
imgview.exe, 3-13
mkhpgl.exe, 3-12
tracepts.exe, 3-4
viewhpgl.exe, 3-14

V
vector format, 2-5
viewhpgl.exe, 3-14
viewing files, 2-8
viewing HP-GL format files, 3-12

W
warranty information, vi
wavelength calculation of trace point, 2-9
Windows 3.1, 2-7

installation, 1-8
running under, 1-3, 1-5

Windows 95, 1-7, 2-7
installation, 1-8–1-9

word processor, 2-4
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